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Open your Virtual Machines

Turn on your Laptops

Login to Windows using “User”

Select the nRF52840LAB Virtual Machine & click Start

1.
2
3. Open the Virtual Box program
4
5

Log-in using credentials: | Username: ubuntu

Password: ubuntu
6. Open Visual Studio Code (use the App bar on the left) ﬁ@hm
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Prepare the Coding Environment

‘ From the Terminal:
make setup

» valsalice-1i0t-23 make setup
Enter your username: [

¥ Repository se{up complete!

& If you see any (yellow) errors input the credentials again

@ Open the week14 folder in the terminal
@ Right click on the left + “Open in Integrated terminal”

/K@.lsalice
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Recap: Data Types

C has a number of primitive data types:

int
float
char

bool

42 1200 1 200 -3
3.14 0.00001 -2.1
‘A’ NICH ‘\n’

true false

Strings are NOT a primitive data type, and have special syntax.

strings ‘ "Hello™" \

"A"
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"T am a full sentence!"
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Recap: Variables

A variable is a named container that stores data or values.

int x = 42;

float yv = -0.12;
char w = 'A';
char z[50] = "Full sentence";

Booleans require a custom include statement:

#include <stdbool.h>

bool hello = true; @
/K alsalice
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-
Recap: Boolean Operators

Greater than | >

Greater or equal than | >=
Less than | <

Less or equal than | <=

Equals | ==
Not equals | !=

Not !

/K@lsalice
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Recap: Chaining Comparisons

e and (both must be true)

true && false

(5 < 6) && (5 < 10)

e or (either must be true)

true || false

(5 < 3) || (5 < 10)

e not (negation)

'true

(5 < 3)

Alberto Spina
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Recap: If-Statement chaining

You can chain multiple conditions with else if.

What is the difference between these two snippets of code?

int num;

scanf ("sd",

if (num < 3)

} else if

printf ('

&num) ;

{

'Small number\n") ;
(num < 10) {

printf ("Medium number\n") ;

Alberto Spina

int num;

scanf ("%d",

if (num < 3)

}

}

printf ('

printf ('

&num) ;

{

'Small number\n") ;

if (num < 10) {

'Medium number\n") ;

/K@lsahce
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Recap: While-Loops

Repeat parts of |int num
printf ("Input a number greater than 100: ");

your code!

scanft ("sd", &num) ;

while (num <= 100) {
printf ("Wrong number, try again: ");

scanft ("sd", &num) ;

printf ("Well done!\n"); @ |
] jlsallqe
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Recap: For-Loops

Repeat a specific amount of times!

int x; int x
for (x = 1; x <= 5; x++) { while

printf ("Hello %d\n", x); X
}

Alberto Spina

:O;

(x < D)

+= 1;

{

printf ("Hello %d\n", x);
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Recap: Arrays

Modifiable containers for data.

With variables: With a list:
int numl = 42; int arrayl[] = {42, 100,
int num2 = 100; 10},
int num3 = 10;
for(int 1 = 0; 1 < 3; 1i++)
printf ("$d\n", numl); {
printf ("$d\n", num2); - printf ("%$d\n",
printf ("$d\n", num3); array[i]); i
| %é@;mm@
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Recap: Accessing Array Elements

To access array elements you can use the [index] operator.

NOTE: List indices start from 0

index:

01

int arrayl[] =

{17, 28,

33,|| 56,

6};

printf ("%d\n", array[0]):;

Alberto Spina

printf ("%d\n", array[3]):;
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Recap: What is the nRF528407?

Reset
Button

WIWasIIpa
HO. \NONODIWAS

RGB LED

Programmable
Button

=
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o
=

0
®
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Recap: The LED Library

#define RGB_LED RED

1
#define RGB LED GREEN 2
#define RGB_LED BLUE 4
#define RGB LED MAGENTA
#define RGB LED YELLOW

RGB_LED RED | RGB LED BLUE)
RGB_LED RED | RGB LED GREEN)

#define RGB LED CYAN

(
(
(RGB_LED GREEN | RGB LED BLUE )
(

#define RGB LED WHITE RGB LED RED | RGB LED GREEN | RGB LED BLUE)

void rgb led off (void);

volid rgb led set (uint8 t colour);

/@lsahce
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Recap: The E-Timer Library

/* Event generated when a timer expires */

#define PROCESS EVENT TIMER 0x88

/* Set the amount of time on the timer. Also start the timer */
vold etimer set (struct etimer *et, clock time t interval);

/* Restart the timer with the previously set amount of time */
vold etimer restart (struct etimer *et);

volid etimer stop (struct etimer *et);

2 R R ——————— * /
/* Check if the timer has completed */
bool etimer expired (struct etimer *et) _'

A\ alice
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Recap: Using an E-Timer

o

PROCESS BEGIN () ;
.* etimer set (&blink timer, BLINK INTERVAL) ;

#define BLINK_ INTERVAL (0.2 * CLOCK_SECOND)

static struct etimer blink timer;

PROCESS THREAD (demo process, ev, data) {

while (true) {

PROCESS WAIT EVENT () ;

if (etimer expired(&blink timer)) {
etimer reset (&blink timer);

// Do something on timer expiry

}
PROCESS_END () ;

Alberto Spina
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Recap: Networking Packets

e Networking involves transmitting data over a medium.

e Information is transmitted in packets: small chunks of data

(of arbitrary length) sent over the network.

Alberto Spina

PACKET

>

>
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Recap: Receiving Packets

We provide a helper
function to simplify

receiving packets over
nullnet:;

receive_nullnet_data

You can add functionality

inside the function
body.

Alberto Spina

/* Helper function to receive data over nullnet */

void receive nullnet data (
const wvoid *bytes,
uintl6e t len,

const linkaddr t *src,
const linkaddr t *dest)

{

int data;

memcpy (&data, bytes, len);

printf ("Data received: %d\n", data);

}
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Recap: Disambiguating Packets

typedef struct {
To know where packets are

coming from we add a team_id
field to packets.

char team id;
int command;
int data;

} message t;

To use this field in the next
exercise you MUST set the
TEAM_ID macro at the top of
the file.

// IMPORTANT!
// Change the 'TEAM ID"!

#define TEAM ID 'Z'

/K@lsahce
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Recap: Sending Packets

We pI’OVIde a helper /*lielpez1 furicl:tiindti s(elnoTt d;tta )ov{er nullnet */
funCtlon to Slmpllfy printf ("gending ;ata: sd\n", data) ;
Sendlng EaCkets over nullnet buf = (uint8 t *)é&data;

nunnet' nullnet len = sizeof (data);

NETSTACK NETWORK .output (NULL) ;

send_nullnet_data \

You can call this function
but you should NOT edit

|t variable = 42;

send nullnet data (variable); /K@lsahce
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Recap: Cooja
Cooja is a Simulator for the Contiki-NG Operating System.

It allows for Contiki-NG programs to be compiled and executed
on virtual simulated test-beds.

The simulated motes will behave similarly to the real world.

@ rrom the Terminal run the make cooja command:

make cooja :
/K@lsahce
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Recap: Adding a Cooja Mote

‘ Let's add a new Mote:

Motes > Add motes > Create new > Cooja mote

RPL - Cooja

File Simulation JUlIEEN Tools Settings Help

ot g2 o —

Start/Pause SERAGLERTGEE .
Disturber mote...

- Mote types...
= e S[=eI) Import Java mote...

| } | Z1 mote...

{ { Sky mote...

| |

/@lsalice
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Recap: Adding a Cooja Mote

@ rut“sender” in the description
‘ Use the firmware under (you can also use “Browse”):

/home/ubuntu/Documents/valsalice-iot-23/lab/weekl4/simple/sender.c

Create Mote Type: Compile Contiki

Description: ‘Sender

L Contiki process / Firmware: /home/ubuntu/Documents/valsalice-iot-23-template/lab/weekl 4/simple/sender.c Browse

[7 Clean | [ Compile J

‘ Click “Compile”

‘ Click “Create”

Introduction to loT
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Recap: Adding a Cooja Mote

‘ Put “1” in the “Number of new motes” field

Add motes (Server) X
Number of new motes 1 Q
' AL WA

Positioning [Random positioning _vj
Position interval X WO = 100 :

Y © == 100

z |o <> (0

[ Do not add motes J [ Add motes J
Click “Add tes” I
® Youshould get this

Alberto Spina
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Recap: Adding a Cooja Mote

@ After you create the Mote it will be available for quick

access in the simulati

on.

File Simulation

[UEEN Tools Settings Help
[  Start/Pause SER-te[Nylad=13 >

5

View Zoom

Mote types...
Remove all motes

|”

Sender 4
Receiver
Relay <

7| Create new mote type >

(10) Simply click on the Mote name to create new motes of

that type

Introduction to loT
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Recap: Opening a Cooja Simulation
Open an existing Cooja Simulation

File > Open simulation > Browse..

¥ Simulation Motes Tools Settings Help
New simulation... Ctrl+N d limit: 0,01 X J,1)
2Pe s Browse... < B =
f_: e “ ! ) Open and Reconfigure 2 i - 7 -
— — Look In: Uﬁ’weekls ﬂ [@JL@JL@J\@'@
iﬁreca l
[;B‘;tﬂoﬁo?ég}{.icséf S
Open the topology.csc file
. . File Name: topology.csc
I n S I d e t h e Week1 5 d I re Cto ry Files of Type: | Cooja simulation (.csc, .csc.gz) vv]
[m] L Cancel JElsalice
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Recap Exercise

Receiver

A\ Directory: week15

‘ Open the file:

topology.csc

® Add:

1 Sender Mote
1 Receiver Mote

Sender

rd

® <— Relay

3 Relay Motes

Arrange them as displayed
T

School Year 2023-2024
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Save remotely your Changes

make save

lPassword

Git: https://aspina@git.spina.me (Press 'Enter' to confirm or
'Escape’ to cancel)

¥ Changes committed and pushed. All done!

/K@lsalice
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Recompiling Mote Code

To recompile motes you simply reload the simulation

Simulation > Reload Simulation > Same seed

Simulation

Motes Tools Settings Help

4 Start simulation Ctrl+S  Jimit: (U 0.01X() 0.1X® 1X( 2X() 20X Unlimited
Reload simulation >

Information...

Reload with same random seed
Reload with new random seed

Ctrl+R
Ctrl+Shift+R

SHORTCUT: You can simply press Ctrl + R

Simulation load error X

| Compilation output | Java stack trace |
L] L]
E rro rS WI | | b e ra I Se d ° > make -j6 team_sender.cooja TARGET=cooja
d cc team_sender.c
team_sender.c: In function 'send_nullnet_data"

team_sender.c:23:1: error: expected ')’ before '}' token
23|}

Introduction to loT School Year 2023-2024
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Header Files

#ifndef CONFIG H config.h
#define CONFIG H

Header files allow you to define types,
structures, or common code once and
reuse it in multiple source files /* Message Configuration */

typedef struct
{

char team 1id;

#include "config.h" file.c int data;

} message t;

printf ("Team ID: %c", TEAM ID);

#define TEAM ID 'Z'

#endif // CONFIG H

Alberto Spina Introduction to loT School Year 2023-2024
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Exercise Wrong =

A\ Change the TEAM_ID in config.h!

There are three types of motes: ® ® c

f /
1) Team Sender: \ Receiver
|

Sends messages every 10 seconds

. -—fe Sender
2) Recelver:

Receives messages and repeats correct ones

3) Wrong Sender:

Sends wrong messages every second (e
Introduction to loT School Year 2023-2024



]
Exercise >

A\ Change the TEAM_ID in config.h!

Implement in week15/team: ® ® G

1) Team Sender (team_sender.c):

// TODO (1): Send “datum  over nullnet

// TODO (2): Also reset the “periodic timer" _4P

2) Receiver (receiver.c):

// TODO(1): ONLY IF the team matches: repeat the message!

// TODO(2): ONLY IF ‘data’ is different from ‘last received data': repeat 4
the message! alsalice
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Exercise Solution

Wrong Packet Route: Team Packet Route:
+ P
|
©) ® g i—b O e @

/k\ Jalsalice
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Test that it works

/N Open a new terminal in_week15/team

1) Flash the team_sender firmware:

make team_sender.dfu-upload

/\ 2) Move the sender mote to a different machine!

3) Flash the receiver firmware and make login:

make receiver.dfu-upload

make login /K@lsahce
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-
Save remotely your Changes

make save

lPassword

Git: https://aspina@git.spina.me (Press 'Enter' to confirm or
'Escape’ to cancel)

¥ Changes committed and pushed. All done!

/K@lsalice
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The Real World

In the Real World not 100% of

messages sent is also received.

Cooja allows us to model this
PRR

statistically: messages now have

a packet reception rate (PRR %).

/@lsalice
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Exercise

®
A\ Change the TEAM_ID in config.h!
@ O,
Open the following Cooja simulation:
topology3.csc
) & —
Implement in week15/lossy: ™
Sender
1) Sender (sender.c): A
// TODO Try sending multiple times in a row
2) Receiver (receiver.c): ®
// TODO Try sending multiple times in a row ﬂ@lsaﬁce
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Quiz Time!

ahaslides.com/HZ2CU

/K@lsahce
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End of Class

See you all next week!

/K@lsalice
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